}VAVA AVA
AVh v
OSSR

MUDE (CEGM1000 25)
Introductory Questionnaire

SRR
I Vavatuii s

ng way  Paly

N
K]

Modelling, Uncertafnti, and Data for Engineers

Use your phone to scan the QR
and answer this survey!
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Type the URL into your browser:
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Nice to meet you!

Go to: vevox.app
Session ID: 147-912-491

]
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Modelling, Uncertainty and Data for Engineers (MUDE)

Cross-Discipline Expertise

Landing zone

Engineering fundamentals related to M, U, D

Improve coding literacy

Deep Discipline
Expertise

12 EC, Q1 + Q2, all programmes
[ >300 students! ]

T-Shaped Skills

“
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Welcome TR E———
MSc students  —————
2025-2026 '

Prof.dr.ir. Stefan Aarninkhof
Dean of Faculty of Civil Engineering
and Geosciences (CEG)

Sept. 2, 2025
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Eastern Scheldt storm surge barrier (\NL)




Professional timeline

Year

Affiliation

1990-1996 Civil Engineering, TU Delft

1995 Ecole des Ponts et Chaussées, Paris

1996-2003 PhD @ TU Delft

1996-2006 Delft Hydraulics (nowadays Deltares)

2006-2016 Boskalis

2016-present Professor of Coastal Engineering, TU Delft
2020-2024 Chair of Hydraulic Engineering Department
2022-2024 Director of EcoShape | Building with Nature
2024-present Dean, Faculty of Civil Engineering and Geosciences

e
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Drivers for CEG

= Climate change

= Energy Transition

= Urbanisation & Mobility
= Clean water

= Resource availability

= Biodiversity

= Infrastructure replacement
& restoration
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Our scope

X 15 : (TN Geoscience and Remote Sensing
Water Management L A

Geoscience and Engineering \"f({/
U
b

)
- WATER STRUCTURES
EARTH SYSTEM INFRASTRUCTURE

NATURAL RESOURCES MATERIALS

Engineering Structures _ / S /% = S Materials, Mechanics,
i [ : o - ) Management & Design
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Importance of
fundamental
knowledge

Complex, density-driven
currents cause difficulties
with placement
Maasdeltatunnel (Rotterdam)

GEBROKEN KABEL
“%h

~ Herstel'mlsl k “
Maasdeltatunnel ‘gaat maande'h_
duren’

Gepubliceerd op 13-06-2023 om 17:05

De voorbereiding van het afzinken van het eerste tunneideel in maart. © ANP / Hollandse Hoogte / MediaTV ‘

et beschadigde deel van de Maasdeltatunnel gaat eind juni naar een reparatiedok in de Botlek in Rotterdam.
Dat maakt Rijkswaterstaat in een online update bekend. De beheerder verwacht dat het tunneldeel na aankomst
‘ongeveer drie maanden” op het dok ligt.

Het tunneldeel botste in april tegen een kade tijdens een mislukte afzinkoperatie op het Scheur tussen Rozenburg en

Maasdeltatunnel, Nieuwe Waterweg (2023)

aassluis. Daar moet de tunnel uiteindelijk onder water komen te liggen.



CEG 1n a changing
world

= Focus on UN Sustainable
Development Goals (SDGs)

Mjm | : ‘ :ﬂ’“ 7,~~ % "
{ Al
)Fx " gj‘*\'m” T"# “"“‘-a rmﬂuu u-: g.m-y. :'
! l!l\ ;‘L

*» |ncreased stakeholder
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= New technologies
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What is MUDE?

* What do current professionals need?
— Programming literacy
— Modelling concepts
— Data structures and analysis
— Uncertainty/risk comprehension
» Multidisciplinary group work helps to facilitate this

15
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What is MUDE?

NOT about applications from your specialization
o Get grounded in fundamentals applicable across the fields
NOT a math course as you know them from your BSc
o Taught by CEG staff, connected to CEG applications

NOT crash course in Python
o Some prior experience is expected, means to catch up are there

NOT going to make you a "pro" coder
o Get comfortable with coding, see a host of cool implementations

16



MUDE: 1n a nutshell

Theory & Applications (~60%)

« \Website and online book

« Applications drawn from all programmes
Theory & Application

Group Assignments (~30%)

* Apply theory and programming to real problems

« Submit a weekly Report

« Collaborative and multidisciplinary

Programming

Programming (~10%)

« Coding and software engineering skills

« Effective documentation and communication
« Weekly Programming Assignments

Group Assignments

]
TUDelft



Who are your MUDE teachers?

« Over 50 people involved! * J-ee-ah (Jug, See, Art)
* Lei(Lay an egg)

« Many familiar faces = you will meet them in class
* Your MUDE Guides

- The best people to ask about logistics, personal issues, etc (MUDE-CEG@tudelft.nl)

—> At least one of us will always be present in every class session

TUDelft



Theory & Application
Weekly Content

]
TUDelft

Modelling

1.1 Landing zone — Introduction to Modelling
1.2
1.3
1.4 Univariate distributions

1.5 Multivariate distributions
1.6 Uncertainty propagation
1.7
1.8

Numerical modelling

Observation Theory

Partial Differential Equations, Finite Difference
Modelling and Finite Volume Modelling

2.2 Finite Element Modelling

2.3 Signal Processing

2.4 Time-Series Analysis

2.5 Optimization

2.6 Machine Learning

2.7 Extreme Value Analysis

2.8 Risk & Reliability 2-9-2025 19
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8:45
Group

Assignment*

08:45-12:30
10:45 Workshop

10:45-12:30 Multiple rooms
Lecture
10:45-12:30 Multiple
rooms

12:45

*compulsory
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Group
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08:45-12:30
10:45 ( Question \ Workshop
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Buddycheck

* You are in the same group for a quarter
* Weekly survey on how groupwork is going
» Buddycheck will not be seen by your groupmates

+ Important to inform us as early as possible so we can help if there are any concerns or issues

* Opens on Friday, due on Monday

PART OF YOUR PORTFOLIO

]
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Programming Learning Line

* Provides essential programming skills,
based in Python

W _operation -2
« Content based on inputs from industry .‘,’,3:—3:::3
(e.qg., Deltares, HKV, RHDHV, RWS, ...) Wirror_mod.use 7
. "electi
- Some examples of what you will learn: R e 2 ™ -
jer_ob.select=1
- Coding standards and good practices ‘.Se R il
- ecte + SsSUr 1
- Effective documentation, communication, "";g;fiﬁ;iiﬁi;;ied_ob :
visualization sata.objects[one.name].seM

rint(“please select exacthy '™

- Debugging, Version control

_ OPERATOR CLASSES -~~~

* And more!

]
TUDelft porteX); o ob 1 26




Programming Learning Line

Weekly programming assignments:
* New programming topics

 Preparations for workshop and group
assignment

* Fundamental programming concepts

Struggling with fundamental programming
concepts =2 self-study required! Join
programming tutorials on Tuesday in Q1 week
2-5

]
TUDelft

W _Operati

- use_z

TOr_mod. use_x
ir ‘ror_mod. use_y
TOor_mod. use_z

"election at the end -
_Oob.select= 1
fer_ob.select=1
Mntext.scene.objects.actiw
wi"Selected” + str(modifier i
Birror_ob.select = 0
bpy- context.selected_ob
data.objects[one.name].se

rint(“please select exacthy '™

_ OPERATOR CLASSES -~~~
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Practicalities: Personal Computer

* You should have one! (Mac, Windows, Linux are all OK)
* Bring it with you

« Keep it closed during Monday lectures

« Wednesday workshops may include Jupyter exercises

* Friday will definitely require a computer

* |Is this an issue? Contact MUDE-CEG@tudelft.nl immediately.

]
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Practicalities: Assessment

« 60%: 2 written exams (Q1 + Q2)

* 40%: Project Portfolio
* 70%: Group Work (weekly)
* 15%: Programming Assignments (weekly)
* 15%: Buddycheck (weekly)

« See MyTimetable for up-to-date exam info

]
TUDelft

Q1 Exam (30%)

Q2 Exam (30%)

Project Portfolio (40%)




Speclal Requests

= Does anyone want to work in a group in a separate room?
= i.e., Quiet place

= Email MUDE-CEG@tudelft.nl

= We will prioritise students with special sensory or learning needs!

]
TUDelft
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Using ChatGPT 1n MUDE?

* |s it feasible?

X
* Yeah
©) ChatGPT - Bot
- s it practical?
©) chatGpT
Yes, there is a way to animate confetti falling in PowerPoint. Here are the steps ® N O Way'
to do so:

1. Insert a shape, such as a rectangle, on the slide.

2. Right-click the shape and select Format Shape.

3. In the Format Shape pane, select Fill and then choose Picture or texture fill.
4, Click the File button and choose an image of confetti.

7. Duplicate the shape multiple times and arrange them around the slide.

I 5. Adjust the transparency if needed.

9. Go to the Animations tab and choose an animation effect, such as Fly In.
10. Adjust the animation settings as desired, such as duration and direction.
| hope this helps! Let me know if you have any other questions.

Tell me more =

T T T L L 1T T SO = SRR SERS FAP A S ST = | H e

]
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* Yeah
 Is it feasible still?

* Yeah |
* Is it practical now?
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efinitely not!!!

animate the shape®
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is there a way to animate falling confetti in pnwerpuseD

Yes, you can animate falling confetti in PowerPoint using built-in animation tools. While PowerPoint doesn't

have a default "confetti” animation, you can create the effect manually or use pre-made elements. Here are a

few ways to do it:

Option 1: Use Pre-Made Confetti GIF or Video

Easiest method

1. Find a confetti animation (GIF or video with transparent background):
« Search for "confetti transparent GIF" or “confetti green screen video.”
« Ensure it's a looping animation if needed.
2. Insert into PowerPoint:
» Go to Insert > Pictures (for GIFs) or Insert > Video.
* Resize and position it at the top of the slide.
3. Set to autoplay:
» Select the video/GIF.

+ (o to Animations = Animation Pane > Start With Previous.

4. (Optional) Remove green background using the Remove Background tool or video editing beforehand.

* This year, it finally tells us to
get an external image!




Option 2: Create Confetti Effect with Shapes and Animation Septemb

More customizable but time-consuming

1. Draw confetti pieces:

* Insert small shapes (circles, stars, rectangles) in different colors.

y Use Insert-';» Shapes. * But it’s still Suggesting the old
2. Animate them: . .
way in option 2!

* Select each shape.
* Go to Animations > Add Animation > Motion Paths > Down.
« Adjust the duration to make the fall slower (e.g., 2-5 seconds).

» Use Timing > Start: With Previous or After Previous. ¢ YOU can use ChatGPT, but

« Add Spin or Grow/Shrink animations for more realism.

* Be careful with the results

3. Duplicate and randomize:

+ Copy multiple shapes. * Get assisted, not replaced

* Vary the motion path direction, duration, and start time slightly to make it look natural.

* Let us know when you use it

Option 3: Use PowerPoint Add-ins or Templates

There are some animated PowerPoint templates or add-ins (like PresenterMedia or Envato Elements) that

offer pre-animated confetti effects.




Practicalities

All material is accessible through the website:

mude.citg.tudelft.nl

Brightspace: Course information, announcements and updates. Join CEGM1000-25!

Online textbook: mude.citg.tudelft.nl/book

Questions and answers: answers.citg.tudelft.nl
MUDE email: MUDE-CEG@ftudelft.nl (personal issues only)

]
TUDelft
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10 min break... MUDE (CEGM1000 25)

If you haven't already, Introductory Questionnaire
use your phone to scan the QR
and answer this survey!

OR

Type the URL into your browser.

%
TUDelft https://forms.office.com/e/itvaQC3jaR



Introduction to
modelling

* What's a model?

* In short: a model is a purpose-built
abstraction of physical reality

* Let's see it in more detail.

9/2/2025



What 1s a model?

A model is a purpose-built abstraction of physical reality

* We interact with complex systems in reality

* How will the river respond to the discharge?
« Temperature? — Heat transfer

« Erosion in the margin? — Hydrodynamics and sediment
transport

« Contaminants? — Water quality

"Anglo American's Drayton mine - mine water discharge" by lockthegate is licensed under CC BY 20.

* Then we make an abstraction to analyze the aspects we are
interested in

9/2/2025



The modeling workflow

Mathematization: from real world to equations

Computation: finding the solution to the equations

Interpretation: connecting back to real world

Validation: comparing model results to real observations

Additional (iterative) steps:
 Verification: check computation results

» Calibration: tweak model parameters

9/2/2025

Real world Mathematical model
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engineering question



Modelling in MUDE

Real world

Mathematical model

ol

¢ 6 4 Mathemat zation N 00 . R

Real situation
Engineering question

Validation

Prediction

N

@ Interpretation

Proposed answer to the
engineering question
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Governing equations
Problem definition
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What iS ad m()de]_? A model is a purpose-built abstraction of physical reality

Real world Mathematical model
@ J? Governing equations ® Once We have the mOdel:
Problem definition
00 0 Mathematization
Real situation ’ = B Ao Df&t +v86%J+R
Engineering question at - 0z ) )
’a 4ol@) » Computations: use it!
\\\* 9
: s * Interpret the results to get the answer to your
5 = question
§ 5
Mathematical solution
Prediction Numbers, fields, ...

- I Track-related!!

N
@ Interp etation ’

Proposed answer to the
engineering question

9/2/2025



A note on Digital Twins

Y

Physical Digital
Counterpart  Counterpart
» Real-life « Reflects state
system of physical
counterpart
« Often has
sensors to « Updates
capture based on
current state Incoming data

]
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Classifying Concept:

MOde].S Simplified representation of a system or phenomenon
Conceptual models Uses simplified concepts and relationships to understand a process

Mechanistic models

_ Examples:
Phenomenological
models Water cycle

: Nodes and links to represent road networks
Data-driven models

Evapo-transpiration
Fertilizer 4 Reinfall
. N B O8N SN )
' 1 8.8 -8"'8
[ ’ .8 8. 8
" ' L B
;. Graing 2
4 "v s\‘ -
. ‘ Wastewater
Vegetation \ ‘ 2
K Infiltration v descharge
\\\ Catchment
~ ~& export
~ Sedimentation load
Groundwater Labsorplion e P~
ZONC iy o ST T e e 't S i e —:-’4#— — ‘
Erosion & desorption

4 dischar
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Classifying
Models
= Conceptual models
Mechanistic models

Phenomenological
models

Data-driven models

%
TUDelft
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Concept:

Physical, chemical, or biological laws to describe the
behavior of constituting parts of the modeled system

Embodies the idea that a complex system is the
summation of many basic phenomena

Examples:

Newton’s laws for describing dynamic motion

Weather mOdels #i 1[371? : Tsa? ' '139f: ; 140!: .“l.ii; qu‘r.l lusls

8 88 8 8 3 8

- - m ] v A
10 20 30 40 50 60 70 80 90 100 110 120 130 140 150 180 170 180 180 200 210

Atmoz, CC BY-SA 3.0, via Wikimedia Commons




Concept:

ClaSSlfYIIlg Mathematical consistency between quantities,
MOde]_S relationship between quantities is hypothesized

= Conceptual models Model is constructed by setting up appropriate
experiments, measuring observations, fitting
hypothetical structure with data.

Mechanistic models

Phenomenological

models

_ Examples:
Data-driven models _ _ o
Behavioral modelling (e.g. route choice in transport)

Friction modelling

%
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Classifying

Models

= Conceptual models
Mechanistic models

Phenomenological
models

Data-driven models

%
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Concept:

Use of data to create empirical and probabilistic
relations between the desired output and input

Examples: Models can also be a
Large language models combination of different
Weather models (increasinalv) types of model!
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Trade-offs Complexity

How detailed does the
model need to be?

How well does it need to ﬁ
PIES “Very realistic model,
reflect rea“ty : é prohibitively expensive”
|

What is our budget? %

Affordability ﬁ Accuracy

“Cheap and functional,
but limited scope*”

%
TUDelft




[.et's assess some models

Go to: vevox.app
Session ID: 147-912-491

]
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Examples only:

-

Goodness of Fit KS test
\ % 08
o
= Methods that gives insight into the performance of models e 06
= For example: % 04
= Square differences G 02
= Pearsons chi-square test o
= Bias
3.5 ! ! ! ! IOt
= And many more! 30k QQ P
Gosfooo
EE.U-
= More on this throughout MUDE! Ol
0.5F

085 05 10 15 20 25 3.0
Weibull(1,2) theoretical quantiles
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Uncertainty Classification

* Aleatoric — ‘coin flip'

Inherent uncertainty in a system

Epistemic — lack of knowledge

Limits to what we know and can measure

Error — deficiency in modelling and simulation

Limitation of modelling or data collection methods

]
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What type of uncertainty 1s present?

Go to: vevox.app
Session ID: 147-912-491

]
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Main takeaways

* Models are an abstraction of reality

«  There are many possible choices for a model
* No ‘right’ model, all about purpose

* Need to consider assumptions, uncertainty
sources etc.

When dealing with Modelling, Uncertainty and Data,
Engineering context matters!

For reliable Engineering, understanding tools for
Modelling, Uncertainty and Data matters!

]
TUDelft
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Nenana Alaska ..

[ce Classic

Chukchi Sea
ALASKA*Falfbanks
YUKON
Anchorage
o
r __________________
(30“ of Alaska
JSea b

9/2/2025



What does the Nenana Ice Classic have to do with MUDE?

140 A

= Predict the day and time of "break up"

135 A

Days till break-up
= =
N w
w o

=
N
o

Nenana Ice Classic

"""" NN

Average February and March Temperature (°C)

10.4 °C
2020
1:2°C€
\, I*
WAV @ .
A s5.7°C
"‘A'/V' \
AN
—— 7 year average
—— RCP8.5
—— RCP4.5
—— RCP2.6
1925 1950 1975 2000 2025 2050 2075 2100

Year (-)




What does the Nenana Ice Classic have to do with MUDE?

- Analyze the data (time series, signal processing)

* Formulate physics-based and data-driven models to predict break-up date
and time

« Maximize probability of success
« Optimize the betting strategy

These are all MUDE topics!

]
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What now? MUDE (CEGM1000 25)
Introductory Questionnaire

* Fill out the Questionnaire

* Visit the MUDE Website and read it
* Read the Book!

»  Get your computer ready with PA1.1

* See you in class tomorrow at 10:45!

- Keep an eye on Brightspace

]
TUDelft https://forms.office.com/e/itvaQC3jaR
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